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Instructor notes
Getting Started
The Adobe® Photoshop® CS4 Classroom in a Book™ course presents students with
tips, techniques, and solutions for using the Adobe Photoshop CS4 software.
The Instructor Notes are intended to complement the information in the Adobe
Photoshop CS4 Classroom in a Book®.
The information is organized to follow the sequence of instruction in each lesson.

Course strategy
If you’re teaching a 15-session class, you can teach approximately one chapter of
this book per class. The book contains 14 lessons, some of which may take a while to
complete. If you are teaching a 10-session class, you may want to combine some of
the lessons in a single class. For example:

• Lessons 1 and 13 are both focused on learning about the Photoshop user

interface (including Adobe Bridge). However, because Lesson 13 also covers
features in Photoshop CS4 Extended, it may be better suited for advanced users.

• Lessons 2 and 6 cover related aspects of photo retouching.
• Lessons 3 and 5 both are about making selections. Also, Lessons 5 and 10 cover
effects that are based on masking and selections.

• Lessons 4 and 9 deal specifically with layers, although layering is a crucial
element in almost every lesson following Lesson 4.

• Lessons 8 and 9 both cover vector graphics. If your students are already

competent in the use of drawing programs such as Adobe Illustrator, they may
be able to skip straight to the project with the Saucer.psd file in Lesson 8.

• Lesson 14 addresses printing issues and topics related to color management;
after basic photo correction, Lesson 2 touches on four-color printing.

Managing student projects
One way to simplify file storage and retrieval in classroom situations is to ask
students to create a folder on their hard disks, name it [Student’s, for the student’s
name] Lessons, and then copy each project folder into the main Lessons folder.
Having students keep all their working files in their own Lessons folder makes it
easy for you to clean up files when a class is over.
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Lesson 1: Getting to Know the Work Area
The first lesson presents an introduction to the Adobe Photoshop CS4 software.
Using the basic commands, tools, and panels, your students will learn general techniques for using the work area efficiently, obtaining information about the image in
front of them, and selecting tools or entering values to change the image. This lesson
also introduces students to the History panel, a valuable tool in undoing and stepping backwards in their work.

Goals for this lesson
How much time you should schedule for this lesson depends on whether your
students already have any knowledge of Photoshop, and on their computer skills in
general. The overall objective for Lesson 1 is to make them sufficiently familiar with
the user interface that they can locate the controls they need to do the procedures
in the rest of the lessons. Additionally, by learning how to help themselves, they gain
confidence and independence. In general, they should be able to do the following:

• Identify and name the key areas of the interface, including the Tools panel,
panels (in general), image windows, and the options bar.

• Open the main menus and submenus across the top of the work area (File, Edit,
and so forth), context menus, and panel menus.

• Use tool tips to identify tools, buttons, and other controls.
• Access and search Adobe Community Help, which includes the full Photoshop
CS4 Help, as well as links to other Adobe and third-party Photoshop resources
online.

Finding tools in the work area
You may want to introduce students to the Photoshop environment by providing a
general tour of the work area. This helps orient the students and provides a review
of the names of the elements on the screen. For example, you may point out the title
bar and remind students that it indicates which publication is currently active. Then
point out the menu bar, the rulers, the page icons, the panels, and the Tools panel.
Students may already be used to keyboard shortcuts as a simple alternative to using
the mouse. Photoshop and other Adobe products allow you to combine keys with
mouse clicks to perform tasks quickly.
Many Photoshop professionals keep one hand on the mouse and the other over
the keyboard to switch tools and modes. You may want to demonstrate how this
method allows you to keep the pointer directly over the part of the image that you’re
editing.
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Encourage students to use commands at first, so that they understand what they’re
doing and how it relates to the application. As they become more comfortable with
the tools and concepts, remind them that shortcuts can help them accomplish tasks
more quickly.

Using the application frame and the application bar
New to Adobe Creative Suite 4 are the application bar and, in Mac OS, the application frame. By default, the application bar is enabled and the application frame is
not. Many lessons include steps that use the application bar, so it’s best for students
to leave it visible, though they may prefer to hide it when they work on their own.
If your students on working in Mac OS, suggest they enable the application frame to
minimize distractions from other applications and items on the desktop. If you reset
preferences at the beginning of each lesson, as we recommend, you’ll need to enable
the application frame each time.

Viewing images
Choosing View > Actual Pixels (or double-clicking the Zoom tool) displays one
image pixel for each monitor pixel. This magnification displays an image at exactly
the same size as it will appear in a web browser. But because monitors can be set to
different resolutions, the real size of an image viewed in Actual Pixels view or in a
web browser will varies depending on the monitor in use.
Many users are unaware that the monitor resolution can be changed. You may want
to demonstrate this. Increasing the resolution makes more room for panels and
images on the screen, but with the tradeoff of making everything smaller.
Finally, you may want to demonstrate how to see a single image at two magnifications simultaneously. To do so, choose New Window from the Arrange Documents
button in the application bar, and then select a 2 Up option. You can zoom into one
view to make detailed changes while viewing the full image in another window to
see the changes in context.
You can also scroll using the keyboard. In addition to scrolling up and down using
the Page Up and Page Down keys, respectively, the Home and End keys scroll to the
top left and bottom right corners, respectively, and Shift+Page Up and Shift+Page
Down scroll left and right, respectively.
Photoshop is unusual in that you can scroll and zoom while you are in most dialog
boxes. This feature is very helpful when applying filters or other adjustments from a
dialog box. You can demonstrate this now, or just keep this in mind when teaching
lessons about dialog-box based filters, effects, and corrections.
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Using the options bar and panels
Students should understand that the options bar is not the same as the toolbar (or
button bar) found in products such as Microsoft Office. In Photoshop, the controls
that appear on the options bar change depending on the selected tool. Similarly,
the options bar cannot be customized because it always represents options for the
current tool. Take care to refer to the options bar by its complete name and not as a
“toolbar” or “button bar” yourself.

Using the History panel
You can use the History panel simply to undo steps, or to use the past as a resource
for painting. It can enable you combine two versions of an image into a single image
that represents the best of both worlds. Make sure students understand that history
states aren’t saved with the document. You can suggest that if students want to keep
different versions across sessions,they should set up an image’s states as separate
layers or documents instead.
To supplement the information in this section of the book, you can tell students
about the New Document command in the History panel menu. This is even faster
than using the Save As command or other multi-step methods of creating new
documents. Point out that they can use this feature by selecting any available history
state or snapshot and then choosing the New Document command. Then, they can
go forward to the latest History panel step of the original document and continue
working, secure in the knowledge that they can always go back to the new file they
created if they want to start over at that point.

Using panels and panel menus
The Tab keyboard shortcut lets you hide all panels instantly, so that you can quickly
evaluate images without distraction. When you’re working on a small screen, it also
lets you use the entire screen to edit images. The Tab key returns the panels just as
quickly.
Show students how easy it is to collapse panels to icons, and then expand the panels
again with a click. In this lesson, students will look at customizing a workspace. In
Lesson 12, they will define a custom workspace in Photoshop that shows and hides
specific panels, based on the type of task they are performing.
You do not need to go into this feature in-depth now, to avoid the risk of information overload in the first lesson.

Using a context menu
Demonstrate how context menus change depending on the content under the
pointer. Right-click (Windows) or Control-click (Mac OS) the following examples:
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• Different layers
• A selection
• Text with an insertion point
• In any list panel
If your students use graphics tablets, encourage them to program their stylus button
to display context menus.

Using Photoshop Help
Choose Help > Photoshop Help opens Adobe Community Help, which includes the
entire Photoshop Help as well as links to other online resources. Show students that
Photoshop Help includes detailed descriptions of filters and important guidelines
for using them.

Using Adobe online services
Students may inquire about privacy concerns related to the Adobe Online service.
You can reassure them that no personal or configuration-related information is sent
from their computer, except that which is explicitly typed in by the user as part of
the voluntary online registration process.

Questions
The following questions are not in the student’s Classroom in a Book.
1 What do you do if you can’t find a tool that you know exists?
2 How can you find the keyboard shortcut for a tool?
3 How can you instantly hide or show all panels?
4 What’s the quickest way to type in a specific zoom percentage?
5 What magnification is the best representation of an image’s size on a web page?
6 How can you open a panel?
7 What is the difference between a panel and an image window?

Answers
1 Look in the Tools panel for a related tool with a small black triangle. That
triangle symbol indicates that holding down the mouse button on that tool
opens a list of hidden tools at that location.
2 Hold the pointer over the tool until the tool tip appears containing the keyboard
shortcut for that tool.
3 Press the Tab key (when you’re not editing text).
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4 Type it into the Navigator panel.
5 Actual Pixels.
6 Choose Window > [panel name].
7 A panel contains a set of related controls that you select and use to work on your
file. You can have many panels open, group them, hide them, and separate them,
among other things. The image window displays the image file. If you close an
image window, you close that file.

Lesson 2: Basic Photo Corrections
Lesson 2 might be have been titled “Photoshop 101” because it gives the students
experience with the most basic and commonly used features—the sine qua non of
digital photo editing. Even rank beginners are eager to learn such practicalities as
how to straighten images that have been scanned in at a crooked angle, crop them,
and fix the colors to compensate for a problem with the exposure. Lesson 2 also
introduces two important concepts: resolution issues and adjustment layers.
Image retouching can be overdone. Help students learn how to look closely at
before images, to see what needs correcting, and at the results, to make sure that the
image has been improved enough—but not so much that it no longer looks realistic.
In addition to the lessons in this book, encourage students to learn more about
scanning, tonal correction, color correction, and image repair and retouching. This
chapter merely scratches the surface of image correction—a skill set that is very
deep, extremely valuable, and involves concepts well beyond the scope of both this
book and the Photoshop documentation. Many books on correction and retouching
are available from Peachpit Press.

Goals for this lesson
At the end of this session, your students should be able to describe the strengths
and limitations of the various retouching strategies, and know which tools to use for
specific repairs.

Scheduling this lesson
Lesson 2 and Lesson 6 contain closely related subject matter. In Lesson 2, students
use the Dodge and Sponge tools to make color changes to a limited area of the
image. Lesson 6 is entirely devoted to making similar kinds of changes, but using
different tools.
If your class sessions are long enough, you could group these two lessons into a
single session. If you do so, the students will have to cope with a few very simple but
less familiar techniques, such as making a selection (covered in depth in Lesson 3)
8
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and working in an image with two layers (covered in Lesson 4). However, the use
of these techniques in Lesson 6 is so elementary that it should not present a serious
problem.

Organizing an efficient sequence of tasks
The steps listed here are the most efficient sequence of retouching steps, so they
should usually be done in the order presented. For example, tone correction should
be done before color correction because correcting tones can have the side effect of
correcting a color cast, reducing the amount of color adjustment needed.

Adjusting your process for intended uses
Students should be clear on the concept that the specific settings applied at many
of these stages will differ depending on the final output. For example, the best
resolution and sharpening values for print and web are much different. In addition,
settings that are best for one medium are often detrimental in another. If a student
knows that an image will be used in more than one medium, the student should
maintain a full-resolution master image, and from it, derive versions of the image
that are optimized for print, web, or other uses.

Resolution and image size
The topic introduces the issue of resolution, which is a concept that students will
grapple with many times in the future. At this point, dealing with this issue may
seem less rewarding to your students than changing the cap color, for example, or
other tasks that have more sizzle and pop to them. You may need to emphasize
resolution in your class discussions so that students start thinking about it.

Supplementing the resolution topics
One way to get students to think about resolution is to demonstrate opening two
images at two different resolutions, cutting and pasting a selection from one to the
other, and pointing out the mismatch. Another way to focus students’ attention
on resolution is to discuss its implications. For example, you might ask students to
describe the issues and tradeoffs involved in some scenarios, such as the following:

• What’s wrong with adjusting the image resolution after you correct and retouch
it?

• What’s the problem with just leaving an image at maximum resolution?
• Somebody sends you a family photograph in email that takes a long time to

download. When you open the image in your browser, you can see only one
small area of the picture so that you have to scroll to get an idea of the whole
shot. What should the sender have done to avoid these annoyances?
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• What’s so terrible about making the file as efficient as possible and then scaling it
up to the size you want?

• How do you increase resolution? Or can you?

Straightening and cropping an image
Students may want to know how to crop without locking proportions. To do that,
simply delete the dimensions in the options bar.

Manually adjusting the tonal range
Beginners will often adjust tones by going straight to the Brightness/Contrast commands, probably because the command names sound like familiar TV controls.
However, it’s best to discourage use of Brightness/Contrast for most situations.
The Levels and Curves controls can make an image lighter or darker while preserving the lightest highlights and darkest shadows. Because of the way Brightness/
Contrast works, it’s far more likely to delete useful tonal information, especially in
highlights and shadows. Students may ask what the Brightness/Contrast command
is for. Because it performs linear changes on an image’s tones, it can be very useful
when working with nonimage channels such as masks. But it isn’t very useful when
handling photographic images. In other words, beginners are not likely to need to
use the Brightness/Contrast command.

Removing a color cast
A 24-bit monitor is needed to see a color cast. For best results, that monitor should
also be calibrated; otherwise it may not be clear whether the cast is in the monitor
or in the image.

Using adjustment layers
You may want to demonstrate the difference between using the Levels command
and using a Levels adjustment layer. The Adjustments panel makes it easy to add
adjustment layers, which are nondestructive. That is, adjustment layers make
changes on separate layers, so they do not affect the actual pixels of the image.
Students will have the opportunity to use adjustment layers throughout the lessons
in this book.

Replacing colors in an image
Be sure students understand that they should complete general tone and color corrections before they perform specific color corrections such as the Replace Color
command or using the Color Replacement tool.
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Adjusting lightness with the Dodge tool
When using the Dodge, Burn, or Sponge tools, the key to believable results is
subtlety. Suggest to your students that they use these tools at low Pressure/Exposure
settings and build up their effects gradually.

Adjusting saturation with the Sponge tool
Caution students about saturating a color past the point that the output medium
can handle. This can easily happen on print jobs, since most colors will exceed the
CMYK gamut long before they appear oversaturated on a monitor. You can show
students how to watch out for oversaturation by using the Proof Colors and Gamut
Warning commands on the View menu.

Applying the Unsharp Mask filter
You might suggest that the Threshold value should be increased for surfaces that
would become too grainy if sharpened at a Threshold value of 0. For example, it’s
common to set the Threshold to a value of 8 or higher for skin areas.

Saving the image for four-color printing
You might make the following points about converting to CMYK:

• The way Photoshop converts to CMYK depends on the CMYK Working Space

set in Edit > Color Settings. For example, if the Settings chosen at the top of the
Color Settings dialog box are U.S. Prepress Defaults, the CMYK Working Space
is U.S. Web Coated (SWOP).

When working on a job for press, students should always confirm with their
printer which CMYK working space is the best match with the printer’s
equipment.

• The appearance of an image after converting to CMYK is often disappointing.

Overall saturation is usually lower and some colors may shift. Reassure students
that Photoshop is simply being honest about what colors can actually be
achieved in the CMYK gamut (assuming that all Color Settings are set correctly).

• The Byte Order setting in the TIFF Options dialog box isn’t usually critical

because most professional graphics programs (such as Adobe products) read
both Mac and IBM PC byte orders.

Supplemental information: Comparing the
retouching tools
Usually, students have little trouble understanding how the Clone Stamp tool works
after they get some hands-on experience with it. However, even after students
become competent in using the Healing Brush tool or Patch tool, they may have
Adobe Photoshop CS4 Classroom in a Book
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difficult explaining how the tool does what it does. If this lack of understanding
makes some of your students uneasy, you might explain to them that the Healing
Brush and Patch tools have to do with reading the texture and color information
separately. Thus, Photoshop collects texture information about the area selected to
be the resource for the retouching and combines it with information about color it
collects from the area designated to be retouched to create unique results. If the students don’t care why the tools work, there’s no need to require them to understand
or explain it. As long as they can use the tools comfortably, that’s fine.

Supplemental information: Best practices
You may want to encourage students to think about these issues before they begin
making adjustments. They should:

• Work with a monitor that’s calibrated and profiled. For critical image editing,
this is absolutely essential. Otherwise, the image on the monitor will look
different when printed.

• Be judicious in correcting images. Any color or tonal adjustment to an image
discards some image information.

• For critical work and maximum preservation of image data, it’s best to work with
images with 16 bits per channel (16_bit image) rather than 8 bits per channel
(8_bit image). Data is discarded in making tonal and color adjustments. The
loss of image information is more critical in an 8_bit image than a 16_bit image.
Generally, 16_bit images have a larger file size than 8_bit images.

• Work on a copy of the image file, not the original.
• Remove any flaws such as dust spots, blemishes, and scratches from the image
before making color and tonal adjustments.

• Use adjustment layers to adjust the tonal range and color balance of an image

rather than applying an adjustment directly to the image layer itself. Adjustment
layers allow you to return to make successive tonal adjustments without
discarding data from the image layer. Keep in mind that using adjustment layers
adds to the file size of the image and demands more RAM from your computer.

• Consider using tools like the Info or Histogram panel in Expanded view, to
provide invaluable feedback on adjustments.

• Make a selection or use a mask (Lesson 5) to confine color and tonal adjustments
to part of an image. Or set up a document with image components on different
layers (Lesson 9). Color and tonal adjustments are applied to only one layer at a
time and affect only the image components on the targeted layer.

Questions
The following questions are not in the student’s Classroom in a Book.
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1 In the Replace Color dialog box, how do you select the color to be replaced?
2 How can you lighten a small area of an image?
3 What is a color cast, and what’s the fastest, surest way to remove it from
an image?
4 How do you sample a selection with the repair tools?

Answers
1 Using the eyedropper, click the color you want to change.
2 Use the Dodge tool.
3 A color cast is an imbalance in the color of an image, which might be caused by
anything from problems with the camera exposure settings to the deterioration
of the original photograph scanned in to create the image file. The simplest way
to remove the color cast is to choose Image > Adjustments > Auto Color. The
Auto Color command automatically reads and corrects the color balance in the
image.
4 The Clone Stamp or Healing Brush tool allow sampling sources in the current
document or any open document in Photoshop. To set the sampling point, select
the Clone Stamp tool and Alt-click (Windows) or Option-click (Mac OS) in any
open document window. You can set up to five different sampling sources at a
time in the Clone Source panel. To set another sampling point, click a different
Clone Source button in the Clone Source panel. (In Photoshop Extended, you
can clone video or animation and set sampling points in the current frame you’re
painting or sample sources in a different frame, even if the frame is in a different
video layer or in a different open document. To clone video or animation frames,
use the Animation panel, select the timeline animation option and move the
current-time indicator to the frame with the source you want to sample.)

Lesson 3: Working with Selections
Goals for this lesson
At the end of this session, students should be able to describe the strengths and
limitations of the Photoshop selection tools, demonstrate how to transform a
selection, and accurately distinguish between the pixels within a selection and the
selection itself.
The selection techniques are fairly easy in themselves. However, the concepts of
selecting, selection borders, and selected areas lead to more complicated ideas and
processes, such as masking, alpha channels, and so forth. For success later, students
should master selection procedures before moving on to more advanced lessons.
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Lesson 5, which covers masks extensively, provides the next level of advancement
for this topic.

About selecting and selection tools
The Single Row Marquee and Single Column Marquee tools, which aren’t covered
in the book, are useful for correcting special cases, such as wiping out film scratches
and scanner artifacts.

Quick Selection
The Quick Selection tool lets you accurately select an irregularly shaped object
without having to manually trace the object’s edges. You may want to encourage
students to consider this their default selection tool for anything that isn’t a regular
rectangle or circle.

Selecting with the Magic Wand tool
Ask students to observe how the selection changes using the Magic Wand tool when
they change the Tolerance value in the options bar or leave the Tolerance value
unchanged, but click pixels of different values.

Moving a selected area
It’s easy for beginners to confuse moving a selection with moving pixels, so it’s a good
idea to verify that students clearly understand the difference.
Several transformation commands appear in the menus, but they all require you to
think ahead. In most cases,try the Free Transform command first: it can perform
any transformation (so you don’t have to think about which command to choose),
and it can transform interactively, which means it’s the most fun and intuitive way
to transform objects. The other transformation commands are most useful when a
precise transformation is required, such as an exact horizontal flip.
If your students discover the Transform Selection command in the Select menu,
explain the difference between it and the transformation commands in the Edit
menu. The Edit commands transform the pixels in the selection. In contrast, the
Transform Selection command transforms the selection border without altering the
pixels. They both come in handy, but using the wrong one can be frustrating.
Emphasize the importance of deselecting. In Photoshop, you can’t deselect an area
simply by clicking a spot outside the selection or by selecting a different tool, as
you can do in many other applications. This may seem like a disadvantage because
it seems to add an extra step. However, its benefits are central to the advanced uses
of Photoshop. You can apply a change to the selected area, often by using another
tool. It would be counter-productive if selecting a new tool caused the area to
be deselected.
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You might remind your class that the “extra step” is also a safeguard. Intricate
selections can time-consuming. Because you must actively deselect, you cannot
accidentally deselect something that you have painstakingly selected.

Making selections
Some students may find selecting to be a tedious and stressful operation if they
feel they have to get it absolutely right the first time. If you observe this, reassure
the students by telling them that it isn’t necessary to achieve a perfect selection
right away. Point out that as Photoshop users become experienced, they’ll perform
a selection in multiple passes. On the first pass, an approximate selection is good
enough. On subsequent passes it’s simply a matter of using any combination of
selection tools and techniques (such as the ones in this topic) to fine-tune a
selection until it’s perfect.

Moving and duplicating simultaneously
You might brainstorm with your students about other uses of this technique in
combination with using the Shift key to constrain movement, such as when creating
web buttons or other repeating patterns.

Cropping an image and erasing within a selection
You may want to point out how the Crop tool can be customized in the options bar
for precise crops.

Refine Edges
Encourage students to try out other Refine Edges option with a selection, to see the
usefulness of different matte colors and backgrounds.

Isolating and saving selections
Point out to students that it’s a good work habit to rename selections meaningfully.
It helps them easily find their work, and keep their work organized.

Questions
The following questions are not in the student’s Classroom in a Book.
1 Which selection tools can draw straight lines?
2 What’s the fastest way to make a semi-circular selection?
3 How do you move a selection with the keyboard?
4 If you make a selection and you missed an area, what’s the fastest way to
correct it?
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Answers
1 The Polygon Lasso tool, or the Lasso tool when you hold down Alt/Option.
2 With the Elliptical Marquee tool, hold down Shift and draw a circle. Then with
the Rectangular Marquee tool, hold down Alt/Option and draw a rectangle over
half of the circle to subtract it from the original circular selection.
3 Nudge a selection by pressing the arrow keys.
4 Just press Shift and use any selection tool to add the missing area.
Beginners often see Photoshop as a simple digital version of a painting canvas or
photograph, but this view does not do justice to the potential of the Photoshop
application or the opportunities it offers.

Lesson 4: Layer Basics
Goals and objectives for this lesson
In this lesson, students begin to think of Photoshop files as structured documents
with parts (layers) that can be edited independently. Successful students will understand that layers give them the flexibility to change their mind at any time, adapt
work at the last minute to incorporate client-requested changes, leverage files to
create alternate versions of an image within the same file, and to do other things
that would be a great deal more trouble on a real paint canvas or in a darkroom.
After completing this lesson, students should be able to correctly explain the following concepts and to describe their importance or relationships to other aspects of
the lesson:

• Basic types of layers: background, image, text
• Transparency (transparent pixels)
• Opacity (semi-transparency of pixels)
• Stacking order of layers
• Layer groups
• Visible layers and hidden layers
• Active (selected) layers and inactive layers

Getting Started
Now that the students have completed a few lessons, many of them probably feel
confident enough to start up Photoshop without even reading the “Getting Started”
topic. Reinforce the idea of restoring default preferences at the beginning of each
lesson so that they see what the book describes.
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Renaming a layer and copying a layer
By keeping the photo, shell, letter, and paper texture images each on its own layer,
they can be reused in other documents very easily and never have to be tediously
extracted from a busy background.

Selecting layers
One common stumbling block for the novice Photoshop user is forgetting that a
layer must be active (selected) in order to be changed.
Sometimes students who are used to working in applications such as Adobe
Illustrator or Adobe InDesign think that they can just click an item they know is on
a separate layer to make that layer active. For example a student might assume that
clicking the shell or the paper texture background would switch the active layer to
the one containing that subject matter.
The good news is that because a selection border is independent of the pixels shown
inside it, you can apply a selection to another layer just by clicking the layer name in
the Layers panel.

Related exercises or demonstrations
To demonstrate the importance of knowing which layer is active, have students
make changes on a layer of a multilayer image and then use the layer visibility icons
to view the changes.
One easy and dramatic way to do this is to make a duplicate layer of a single-layer
image file by dragging the original layer onto the New Layer icon at the bottom of
the Layers panel. Then, in the Layers panel, select the lower layer so that it is the
active layer. Select any color from the Swatches panel and then use the Paintbrush
tool and drag it around the image. Because the active (lower) layer is hidden behind
the duplicate layer, the display in the image window appears unchanged. However,
when you click the eye icon for the upper layer to hide it, the paint strokes you made
early are now revealed on the lower layer.
You can set up another demonstration by selecting half an image and choosing
Layer > New > Layer via Cut so that you have half the original image on one layer
and half on another. Then create a selection border that overlaps the boundary
between the two halves. When you make changes (such as to move, transform paint,
burn, or dodge) to or within the selection, ask your students to explain why you get
the results you do.

Adobe Photoshop CS4 Classroom in a Book
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Changing the opacity and the mode of a layer
If the concept of blending mode isn’t clear to the students, you might want to
explain that the blending mode determines how layers combine, while opacity
determines how much is visible beneath the layer.
It’s a good idea to break out the different levels of opacity and blending modes here.
You might want to ensure that students understand that both opacity and blending mode are options not just for layers, but for layer effects and painting tools, too.
Because of all the combinations, it can be confusing to determine exactly how to
apply or edit an image. Suggest that students apply blending modes and opacity in
the following sequence:

• Blending mode by layer
• Opacity by layer
• Blending mode by effect
• Opacity by effect
• Blending mode by tool
• Opacity by tool
There are a few reasons for this suggested order:

• Blending modes have a more fundamental effect on appearance, so should be
adjusted earlier.

• Opacity lowers the intensity of an existing effect, so it’s good to adjust later.
• Layer blending mode/opacity and styles can be changed at any time, so they
should be adjusted first so that you can change your mind.

Adding a gradient layer
It’s a good idea to make sure that students understand the difference between
Foreground to Transparent and Foreground to White gradients.

Applying a layer style
You can quickly demonstrate the advantages of layer styles over traditional filters:
Make a copy of an image. On the first image, apply a layer style (such as Drop
Shadow), and on the second image, apply the same effect with a traditional filter.
Show how the layer style is easily editable while the traditional filter is not.
Point out that many of the long, complicated recipes for special effects covered
in older Photoshop books are no longer necessary because you can now apply an
instant and editable layer style to achieve the same effect.

18

Instructor Notes

Caution students that the single-key shortcuts in Photoshop (such as V for Move
tool, C for Crop tool) don’t work when you’re entering text because they enter
characters in that mode. Make sure they learn how to exit text-editing mode so
that they can safely switch to other tools. For example, Ctrl+Enter (Windows) or
Command+Return (Mac OS) will apply changes and exit text mode, while Esc will
cancel changes and exit text mode.

Flattening and saving files
Students must understand that once a file is flattened, there is no way to unflatten
it. You can describe it as trying to unbake a cake into its original ingredients. This is
why you should archive an unflattened (layered) original of a file before flattening, in
case you need to return to make changes later.

Using layer comps
Challenge students to think of ways that layer comps provide a time-saving or
practical advantage. They’ll create layer comps in Lesson 9, when they put together
packaging prototypes.

Supplementing the lesson
If your students are eager to learn more about layers, invite them to explore the
options at the top of the Layers panel (the blending mode pop-up menu, Opacity,
Fill, and Lock options).

Questions
The following questions are not in the student’s Classroom in a Book.
1 What’s the easiest way to change the appearance of a layer?
2 How can you change the way in which layers combine visually?
3 How can you make a layer partially transparent?
4 Suppose you have a selection border perfectly drawn around an area of the image
you want to work on, but discover that the wrong layer is active. What do you do
now?
5 Give an example of how you might exploit the fact that selection borders in
Photoshop are independent of the pixels within them?

Answers
1 Apply a layer style, which can include any number of effects, and is reversible at
any time.
2 Apply a blending mode.
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3 Change the opacity of a layer.
4 Easy—you just find the name of the layer you really want in the Layers panel and
click it to make it active. The selection border now applies to the pixels on that
layer, so you can continue with your work.
5 Answers will vary, but one example might be for cutting identical “holes” in
multiple upper layers to reveal that shape in a lower layer. Another example will
be evident later, when they work with Lesson 11: to repeat a shape by applying
filters or other properties in another part of the image without reproducing
the original selection contents. Students may suggest many ways to use the
independent selection border. You might make note of their suggestions, and
then revisit this question at the end of Lesson 5 and ask them if they can do all
these same things using alpha channels.

Lesson 5: Masks and Channels
Masks are a powerful way to control both where and how much an effect changes
an image. This lesson guides students through the extensive Photoshop masking
features. Students start with the easy-to-use Quick Mask. Then they learn about the
relationship between selections, masks, and channels.
This lesson builds on Lesson 3, “Working with Selections,” so make sure that your
students are competent in that area before launching into Lesson 5.

Working with masks and channels
To a beginner, the differences among selections, Quick Mask mode, channels, and
layer masks can be very confusing. You might explain it in terms of the following
key differences:

• Quick Mask mode is fundamentally a selection marquee that’s shown in a

different form. Both are temporary because they disappear as soon as the current
selection is changed.

• An alpha channel (a channel used for selection) is like a Quick Mask that can be
saved with the document, but it doesn’t apply to any layer until you load it as a
selection.

• Alpha channels are different from the channels that make up the printable image
(for example, the Red, Green, and Blue channels in an RGB image). You apply
alpha channels to image channels.

• A layer mask is an alpha channel that’s tied to a specific layer. Layer masks aren’t

covered in this lesson, but you’ll want to keep this distinction in mind when layer
masks appear later in the book.
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Creating a quick mask
Quick Mask mode is great for students because it’s much more forgiving than drawing a selection marquee. In Quick Mask mode, there is never any danger of accidentally “dropping” a carefully drawn selection.

Applying effects using a gradient mask
It’s important for students to understand that this is not just an exercise about using
a gradient to fade an effect. The real point of this is that you can use shades of gray
in a channel or mask to control the intensity of an effect anywhere in an image.
Darker parts of a channel apply an effect more intensely. You may want to demonstrate another common example of this—using a feathered circular mask to create a
vignetting effect.

Colorizing with an adjustment layer
In this procedure, students make a clipping group of the Hue/Saturation adjustment
and paper texture. In the next procedure, “Grouping and clipping layers,” they copy
this clipping. Grouped layers cannot be clipped; only individual layers can be.

Supplementing this lesson
You may want to provide additional emphasis on the concept of loading a selection.
You may also want to walk students through all the options in the Masks panel.

Questions
The following questions are not in the student’s Classroom in a Book.
1 How does painting with black, white, and gray in a channel affect an image?
2 How do you apply a saved mask to an image or layer?

Answers
1 Black areas completely protect an image from changes. White areas are
completely subject to change. In gray areas, lighter areas are more subject to
change than darker areas.
2 Choose Select > Load Selection, and then select the mask (alpha channel) you
want to use.
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Lesson 6: Correcting and Enhancing Digital
Photographs
Photoshop provides many features that streamline the handling and routine processing of digital photographs. From correcting red eye to adjusting Camera Raw
settings, this lesson covers a span of beginner to advanced digital image-editing
techniques. Be prepared for this lesson to generate a lot of interest among your
students.

Goals and objectives for this lesson
Your goal in this lesson is to give your students a well-rounded understanding of
how they can perform many routine corrections to digital photographs. This lesson
is aimed at the advanced hobbyist and/or professional photographer who wants to
use Photoshop to clean up images captured by digital cameras.
Most of the topics and techniques have to do with basic image clean up—eliminating red eye and adjusting the white point and other settings of Camera Raw images,
but it also includes some more advanced techniques, such as the Lens Correction
and Vanishing Point filters. For more practice with the Vanishing Point filter, see
Lessons 9 and 13.
This lesson builds on the techniques that were covered in Lesson 2, so you may
want to consider teaching it following Lesson 2, and then proceeding to Lessons 3
through 4.

Processing camera raw files
Camera raw files are native digital image files that give photographers control over
image data that previously was determined by the camera. Many digital cameras
support raw formats, which allow photographers to adjust white point, tonal range,
contrast, and many other settings directly in Photoshop. Emphasize to your students
that camera raw files are incredibly flexible and give them access to powerful editing
features and more artistic control. However, also point out that you can now open
and edit JPEG and TIFF images in Adobe Camera Raw, as well.
The filmstrip on the left side of the Camera Raw dialog box only appears if more
than one image is open. Reassure students about the yellow caution triangle that
appears in the upper-right corner of the images in Bridge. The warning disappears
after a few seconds; it’s nothing to be alarmed about. It simply appears while the settings are being applied to the camera raw image files.

Reducing noise
The noise in the portrait of the mother and son might be difficult for some students
to see. Be sure to have them zoom into the sky, where it is more noticeable.
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Defining a grid
Defining a grid in the Vanishing Point dialog box using the Create Plane tool is
like stretching a rubber band. As the students start to click, they wrap the band
around the side of the house in the image. A blue outline indicates a valid plane. Red
indicates an invalid plane—Vanishing Point cannot tear off a perpendicular plane
from an invalid plane. Students may simply press Backspace (Windows) or Delete
(Mac OS) to delete the last node if the outline appears red. Or, after drawing, drag
a corner node to adjust the plane. It will turn blue as soon as it becomes valid. To
help with node placement, tell students to press and hold the X key to zoom into the
preview image as they place the nodes.

Supplementing this lesson
Using other lesson start files or your own examples, discuss with students how they
would go about retouching and correcting flaws, color imbalances, artifacts, and
other anomalies in their images. You may want them to name the various tools they
could use, and how, as well as other Photoshop features they would use to accomplish their goals. Try to develop multiple scenarios, and get students to suggest likely
correction strategies.

Questions
The following questions are not in the student’s Classroom in a Book.
1 What is white balance and when/how should you edit it?
2 What is the Vanishing Point filter and when would you use it?

Answers
1 White balance sets the color balance of the image to reflect the lighting
conditions under which the photo was taken. It comprises temperature,
which determines the “coolness” or “warmness” of the image, and tint, which
compensates for magenta or green color casts in the image. It is the first setting
you should adjust in the Camera Raw dialog, which initially displays the white
balance at the time of exposure. You can choose from predefined settings, or
specify custom Temperature and Tint values.
The Vanishing Point filter lets you define a perspective plane in an image so that
you can then paint, clone, and transform images according to that perspective.
You can even create multiple planes that are related to one another, and paint,
clone, and transform across these planes through an image.
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Lesson 7: Typographic Design
Typographic tools in Photoshop are robust and sophisticated. Among the type
features are support for OpenType, extensive character and paragraph formatting
capabilities, and support for a wide variety of effects and transformations (such as
positioning text on a path and warping text). This lesson covers an array of type
features in Photoshop.

Goals and objectives for this lesson
Students who have used Photoshop over the years may be used to working on
images in Photoshop, but switching to Illustrator to work on the type for their
composition.
This lesson demonstrates that you don’t need to switch applications to create
great-looking type in image compositions. The project involves creating type for
a mock-up of a label for a new product (a new brand of olive oil). If students ask
why this work isn’t done in Illustrator, explain that the work could be done in that
application, but the idea is for designers who primarily use Photoshop to learn that
they can do the same work in the application with which they’re most familiar and
comfortable, without switching.

Scheduling this lesson
This lesson stands on its own quite well. It doesn’t have to be taught in lesson order,
but students would do well to first complete Lesson 4, “Layer Basics,” and Lesson
5, “Masks and Channels,” before tackling this topic. Those lessons provide a solid
foundation for the material covered in this lesson.

Adding point type
Students must press Enter (Windows) or Return (Mac OS) after entering the point
size in the options bar to make the setting stick (step 1). Pressing Tab or simply
clicking on another option, such as the Font Family pop-up menu, will cause the size
to revert to the previous value. Students may be frustrated if they don’t press Enter
or Return and can’t get the size value to stick.
Also, make sure your students understand and remember to click the Commit Any
Current Edits button (step 2). If they don’t, they remain in text-edit mode. This
means that the type layer name on their screen won’t match the name in the book,
which can be confusing to students. Also, they’ll have difficulty continuing with the
exercise and performing other operations, such as applying layer effects.
A common mistake among new Photoshop users is to not commit changes, and
then try to enter more type, but find the new type is on the same layer. Show them
that in addition to clicking the Commit Any Current Edits button to exit text
edit mode, you can press the Enter key on the numeric keypad; press Ctrl+Enter
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(Windows) or Command+Return (Mac OS); select any other tool in the Tools panel
(besides the Type tool); or click in the Layers, Channels, Paths, Actions, History, or
Styles panel.

Making a clipping mask and applying a drop shadow
Students may also complain (in this exercise or others) that pressing Shift and dragging doesn’t affect the drag operation—that is, it doesn’t constrain movement. The
effect can be subtle. They might see it better by dragging more slowly, or by dragging
and then pressing Shift after they start, to see the difference. In any case, all positioning of type in this label is approximate. Text elements don’t have to be perfectly
centered or positioned. Students can eyeball it.

Creating a design element from type
This lesson doesn’t explain much about the Anti-aliasing menu, but it’s a topic that
you may want to explore further with your students. Anti-aliasing smooths type
edges by partially filling the edge pixels. The Anti-aliasing menu includes the following options:

• None, which applies no anti-aliasing
• Sharp, which makes type appear the most sharp
• Crisp, which makes type appear somewhat smoother
• Strong, which makes type appear heavier
• Smooth, which makes type appear smoother
Sharp is a common choice for print design, and does a good job of reducing
unwanted “jaggy” edges. You may want to ask students to zoom in to the type and
toggle through the anti-aliasing settings to see the difference. Be sure to have them
zoom back out to see the effect at normal size (double click the Zoom tool to see it
at 100%).

Adding paragraph type from a sticky note
Depending on the typeface that students choose and the exact dimensions of their
text box, they may not need to compensate for gaps in the second-to-last line of the
paragraph. Conversely, they may need to finesse spacing elsewhere in the paragraph.
This is a good opportunity for students to explore the paragraph type controls.

Warping with Smart Objects
Dragging the warp grid may be tricky for some students. The exercise instructs
students to drag guides onto the image window to assist them, but if they click the
wrong handle or an off-center part of a line, the desired contour warp will easily be
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distorted or difficult to achieve. Tell students not to worry. They can undo a drag,
and their warp doesn’t have to be completely accurate or perfect.

Supplementing the lesson
Point out some of the the OpenType options in the Character panel menu. If you
can, bring in examples of well-set type, compared with ordinary type. Discuss with
students typographical features that make type appear finished—for example,
adjustments to tracking, leading, kerning, and baseline shift.

Questions
The following questions are not in the student’s Classroom in a Book.
1 What is the function of the Commit Any Current Edits button?
2 How do you create vertical type in Photoshop?
3 What is OpenType and how is OpenType supported in Photoshop?
4 What is a true fraction and how do you create it?

Answers
1 Clicking the Commit Any Current Edits button takes you out of text-edit mode
so that you can perform such operations as applying layer effects and styles.
2 Select the Vertical Type tool, hidden under the Horizontal Type tool, and click
and type in an image window.
3 OpenType is a cross-platform font file format developed jointly by Adobe and
Microsoft. It supports widely expanded character sets and layout features,
such as swashes, ligatures, and fractions. To access OpenType features, choose
OpenType from the Character panel menu.
4 A true fraction displays the numerator as a superscript, the denominator as
subscript and replaces the slash with a fraction bar. PostScript and TrueType
fonts have true fractions in their character set: ¼, ½ and ¾. You can also make
custom fractions using a OpenType font. Simply type fractions as usual—for
example, 1/2—and then select the characters, and from the Character panel
menu, choose OpenType > Fractions. Photoshop applies the true fraction.

Lesson 8: Vector Drawing Techniques
This lesson introduces vector paths as a way to create smooth lines and as an alternative method of selection. Students will learn how to use vector paths to create
complete drawings and to control transparency.
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Students will also be introduced to easy ways to create vector shapes, such as with
shape tools and custom shapes. At first glance, the Pen tool and paths may seem
peripheral to Photoshop, as vector tools in an image-editing program. This lesson
shows the value of the Pen tool as a way to make selections that are more precise
and easier to adjust than with other selection tools.
The Pen tool is the best tool to use for drawing the following types of selections:

• Simple shapes (except regular polygons, which are best drawn with the shape
tools).

• Synthetic shapes with smooth, regular outlines, such as a coffee mug
• A complex series of straight lines, like a city skyline
While all of these shapes could be drawn using other selection tools, they will be
much easier to edit and refine if drawn as paths by the Pen tool.
This lesson will probably be quite easy for students who have experience with Adobe
Illustrator. For them, all the introductory projects, which involve tracing shapes on
the template drawings, will be primarily review.

Goals for this lesson
At the end of this lesson, students should be able to use the Pen tool to draw both
straight and curved paths, know how to select and deselect a path, and be able to
edit a path with the path selection tools. The student should also understand the difference between vector and raster artwork.

Using paths with artwork
Encourage students to learn the keyboard shortcuts for the Pen tool and path
drawing. As pointed out in Lesson 1, keeping one hand over the keyboard and the
other hand on the mouse can facilitate efficient, uninterrupted drawing. The most
important shortcut to learn is the Ctrl (Windows) or Command (Mac OS) key for
temporarily switching to the Path Selection or Direct Selection tool.
Point out that because you can freely switch a segment between being curved and
straight, there’s no need to draw a path perfectly the first time. In fact, some people
like to rough out a path by clicking a series of corner points, and then refine the path
by adjusting the points and dragging out curves as necessary.

Converting paths to selections
After students finish this procedure, you might review all the ways they have learned
in this and earlier lessons to create and store selections:

• Using selection tools
• Creating alpha channel masks using painting tools
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• Drawing paths with the Pen tool
Discuss when to use each technique and when it might be a good idea to convert a
selection from one form to another.

Creating vector objects for the background
Point out that the shapes created with the shape tools can be fully customized. You
can even demonstrate how a shape can be used as a starting point for a more complex path, such as by drawing a rectangle and adding a point to it.
Make sure students understand the difference between the Rectangle tool and the
Rectangular Marquee tool, so that they don’t select the wrong tool by accident.

Supplementary demonstration: shape options
The book itself doesn’t explain much about the three buttons (Shape Layers, Paths,
and Fill Pixels) that appear on the options bar for the Pen tool and the shape tools.
The crux of the difference between the Shape Layers and Paths options is the difference between drawing a shape and drawing a work path.
The key difference between the Shape Layers option and the Fill Pixels option
revolves around the distinction between vector images and rasterized images, so this
makes an excellent opportunity to review and deepen your students’ knowledge of
these distinctions.
You can demonstrate this very simply. Before you begin, make sure that the
Foreground color is not white.
1 Create a new file (File > New) and use one of the shape tools to draw a couple of
shapes in the image. Draw the first shape with the Fill Pixels option selected and
the second with the Shape Layers option selected.
2 Zoom in, but make sure that you can see at least a small area of each of the two
shapes. Then select the Eraser tool.
3 Select the layer with the first shape on it and try to erase it. Then select the layer
with the second shape and try to erase it. Discuss the results with your class.
In the first case, the eraser removes the colored pixels. If you’ve zoomed in sufficiently, the bitmap nature of the shape will be obvious. In the second case, an error
message appears, saying that the contents of the layer are not directly editable—
that is, they can’t be erased because painting and erasing are features of rasterized
images, not of vector drawings.
To illustrate the difference between the Shape Layers and Paths options, continue
the demonstration, using the same simple drawing.
4 Drag the Paths panel out of the Layers panel group so that students can see both
panels simultaneously.
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5 In the Layers panel, select the first layer (the one with the rasterized shape you
drew).
6 Make sure that the same shape tool that you used earlier is still selected, and
then select the Paths option in the options bar.
7 Draw the shape in the image window, making it a different size than the earlier
shapes. (Optional) You can reinforce the difference between the vector items
and the bitmap shape by attempting to add an anchor point to each of the three
shapes you drew.
8 For each of the two vector items, in turn, do the following:

• Select the layer or work path in the appropriate panel (Layers or Paths).
• Use the Direct Selection tool to select the shape.
• Using the Pen tool, click anywhere along the vector path bounding the shape to
add a point, and then drag the point to change the shape.

9 Try to perform step 8 with the third shape, the one drawn with Fill Pixels
selected, and ask your students to explain why you can’t apply this change to
that shape. Now, your entire class should be able to see and accurately discuss
the difference between the work path and the layer vector mask, as well as the
difference between a shape and a path.

Subtracting shapes from a shape layer
Point out how each path in the Paths panel can actually contain multiple subpaths,
and how any number of subpaths are selectable for stroking or filling.

Rotating the canvas
Students may note that you could easily create the text and rotate it, rather than
rotating the canvas to place it. Discuss with students times that rotating the canvas
might be more necessary, such as when you’re touching up an image with elements
at different perspectives.

Supplementary discussion
You may find it useful to make sure students retain clear understandings of the
distinctions, interactions, and relationships between selections, alpha chanels,
layer masks, work paths, and vector paths.

Questions
The following questions are not in the student’s Classroom in a Book.
1 How do you deselect a path?
2 How do you make sure that a path is saved with a document?
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3 Which tool can change corner points to curve points and vice versa?
4 What are the advantages of using the Pen tool to create a mask? Why not just
use the Quick Mask feature, as done earlier in Lesson 5?
5 How do you customize the Polygon tool?
6 (Use only if you have done and discussed “Supplementary demonstration: shape
options,” in this lesson’s Instructor Notes, with your class.) Why would the Fill
Pixels option dimmed (unavailable) when the Pen tool is selected in the Tools
panel?
7 How do you save a work path?
8 When do you lose a work path forever? Is there any recourse?

Answers
1

Click in an empty area in the Paths panel.

2

In the Paths panel, double-click the path to name it.

3 The Convert Point tool.
4 You could select the spaceship using the Quick Mask method. But by using the
Pen tool to create the mask, you create a vector mask that retains its crisp, sharp
edges at any zoom level. In the image of the astronaut the contrast between
the space ship and the black sky is an abrupt change, and the ship itself has
many long, regular lines, so it makes a good candidate for the Pen tool selection
process.
5 Use the options in the options bar when a shape tool is selected.
6 The Fill Pixels option pertains to rasterized (bitmap) images and layers. The Pen
tool is a vector tool, and cannot draw or edit rasterized images.
7 You can save a work path by double-clicking it in the Paths panel and renaming
it. Or, if you apply a work path to a layer (Layer > Add Vector Mask > Current
Path), the path is saved as a layer mask and automatically named.
8 You lose a work path whenever you start drawing a new work path—that is, start
drawing a new path on another layer—without saving the original work path.
If you want to get recover a lost work path, you can try using either the Undo
command or the History panel to go back to an earlier step.

Lesson 9: Advanced Layering
In this lesson, students learn and review advanced methods for adjusting a layer’s
appearance, combining layers, and controlling the visible areas of layers. They also
work with layer comps, introduced in Lesson 4.
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Other lessons have already presented many of the concepts and techniques in this
lesson. For that reason, this chapter makes a good review of the students’ class work
so far.

Goals for this lesson
By the time students complete this lesson, they should be comfortable working with
layers and performing more advanced tasks with them, including creating clipping
layers and merging layers. They should know how to hide and show layers, create
layer comps, and determine whether to flatten their image or merge layers when
they’re ready to save a file.

Clipping a layer to a shape
Remind students of the fundamental rule that the image to be clipped (masked)
must reside above the object that clips it.

Setting up a Vanishing Point grid
This lesson gives students additional practice using the Vanishing Point filter to add
three dimensions to their image. It’s helpful to point out to students as they work
through these steps that precise alignment of the artwork is important to replicate
the results in the final artwork.

Placing imported artwork
You may wonder why the Place PDF dialog box appears when placing Illustrator artwork into Photoshop. Artwork exported from Illustrator is saved in the vector PDF
format if the Illustrator preferences for File Handling And Clipboard are set to PDF
and the AICB (No Transparency Support). When these preferences are set, placing
images from Adobe Illustrator into Photoshop displays the Place PDF dialog box.
These preferences import or paste art as a Smart Object, rasterized image, path, or
shape layer. When the Illustrator PDF and AICB (No Transparency Support) preferences are deselected, the artwork is automatically rasterized.

Filtering Smart Objects
You may want to suggest to students that they try out other filters and apply them
to the artwork. Filters applied to a Smart Object are nondestructive and can be
adjusted at any time. Lesson 10 introduces Smart Filters and compares their nondestructive effects to other filters.

Adding an adjustment layer
If you didn’t demonstrate the advantages of adjustment layers earlier in your teaching, you can do it here.
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Working with layer comps
Discuss possible uses of layer comps. This lesson treats them as product prototypes.
But they’re also useful for showing different versions of a design, works in progess,
and editions in different languages. You can also compare this use of a snapshot of a
state in the Layers panel to a snapshot of a state in the History panel.

Managing layers
Remind students of good work habits: organize their work into layers and layer
groups so that related artwork stays together and is easier to update, and name layers and groups so they can recognize the contents easily.

Flattening a layered image
In addition to reducing the file size, a flattened version is more compatible with
some other programs (especially nonAdobe applications) or with older versions of
Photoshop. It’s useful to remind students of their options when they’ve completed
work on an image:
Flattening an image merges all layers into a single background, greatly reducing the
size of the file. Merging layers lets you choose which layers to flatten; this technique
combines all selected or visible layers in one layer. Stamping combines the benefits
of flattening an image while keeping some layers intact; it flattens two or more layers and places the flattened image into a new layer, while leaving other layers intact.

Questions
The following questions are not in the student’s Classroom in a Book.
1 Why would you use a layer mask instead of an alpha channel?
2 So far, how many techniques do you know for distorting images?

Answers
1 You would use a layer mask, rather than an alpha channel if you wanted a sharply
defined mask, or one that’s easy to edit.
2 The distortion methods used in this and earlier lessons include transforming and
warping text and objects. Each of these has its own limitations and advantages
and can be used only with specific types of elements.

Lesson 10: Advanced Compositing
In this lesson, students practice colorizing parts of layers or entire layers, and work
with filter effects. Students have an opportunity to create a panorama. This lesson
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also presents techniques for recording and playing automated actions. Of course,
automating tasks is not restricted to the use of filters or any other features.

Goals for this lesson
This lesson is more about being creative with Photoshop than about strict techniques. Students have a chance to explore some of the more artistic applications
of Photoshop as they composite four images into a postcard and then create a
panorama.

Mastering filters
The range of possibilities for using filters goes beyond the scope of this book because
the possibilities are virtually unlimited. Students who are serious about using
Photoshop to create special effects will quickly discover two things:

• It’s worth the time to read about filters in Photoshop Help.
• The best way to understand filters well is to experiment with them, using them in
different combinations and with different settings to see who they affect images.

Be sure that your students understand that Photoshop Help has a great deal of valuable information about filters.

Creating a layer and choosing a blending mode
Suggest that students press Alt (Windows) or Option (Mac OS) while clicking the
New Layer button in the Layers panel. This keyboard shortcut opens the New Layer
dialog box, which includes options for grouping layers, designating a color code,
(not a fill color, as some students assume), assigning a blending mode, and setting
opacity. Discuss why you would use each option, and why it might be handy to set
them as you create the layer.

Applying painting effects
Students can compare the colorized version to the original desaturated version by
turning the Paint layer off and on.

Saving selections
Remind students to save selections whenever there is a chance that a difficult or
time-consuming selection might need to be reused.

Applying Smart Filters
When introducing students to Smart Filters, you can compare them to adjustment
layers. Smart Filters are nondestructive: they can be adjusted, turned off and on, and
deleted, at any time. In contrast, regular filters permanently change an image; once
Adobe Photoshop CS4 Classroom in a Book

33

applied, they cannot be removed. Unlike adjustment layers, however, Smart Filters
can be applied only to a Smart Object layer. You may want to suggest to students
that they duplicate and hide layers that they want to keep in bitmap form before
they convert them to Smart Objects.

Extra Credit
Borders are best kept on a layer separate from the main image, as in this procedure,
so that they can be turned off if necessary.

Supplementing this lesson
Encourage your students to experiment with the different filters on their own. You
could say that the real fun of complex images builds on a foundation of multiple
layers that include multiple filter effects, multiple opacity settings, and multiple
blending modes.
At the same time, make sure that your students are aware of the following issues
about filters:

• The last filter chosen appears at the top of the Filter menu.
• Filters are applied to the active, visible layer or to a selected area on that layer.
• The image mode can be an important issue for two reasons: you cannot apply

filters to bitmap-mode or indexed-color images, and some filters work only on
images in RGB mode.

• Some filters are processed entirely in RAM.

Questions
The following questions are not in the student’s Classroom in a Book.
1 Which blending mode changes the hue of a layer without affecting the tone?
2 How can you quickly colorize an entire layer without making any selections?
3 Where would you start looking for more information about filters?
4 What are some of the differences between filters and blending modes.

Answers
1 The Color mode.
2 Just add a Hue/Saturation adjustment layer and click its Colorize option.
3 Photoshop Help.
4 Typically, blending modes apply either at the layer level or to painting tool
properties. You can apply filters to layers or to selected areas of an image layer.
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Lesson 11: Preparing Files for the Web
Up to this point, most of the lessons in this book have been geared toward print
output. This lesson is the first oriented specifically toward web images.
Lesson 11 introduces slices, rollovers, and GIF animation, as well as optimizing files
for the web. With slices, you can define and link isolated areas of a graphic rather
than having the entire image as a hotspot for just one URL. Students also learn how
to add rollovers to slices, and add interactive visuals as well as links to other web
pages. Note that it’s a good idea to finalize a design before creating rollovers for it.
Animating an image can be as simple as moving a layer across the screen or changing layer attributes, and the process of optimizing an animation for the web isn’t
much different than optimizing a still image. In other words, it’s not difficult to
transform an image from a static graphic to an eyecatching animation.
We encourage students to design in Photoshop and then use Adobe Dreamweaver
to add HTML coding, interactivity, and web functionality to their designs.

Getting started
Students may miss seeing the logo animate in the upper-left corner when they open
their web browser (it animates only once). If they miss the action, instruct them to
use their browser controls to refresh or reload the page.

Selecting a web design workspace
Encourage students to explore the other workspaces supplied with Photoshop.

Creating slices
Note that slicing an image does not make it download faster. In reality, a sliced
image takes more time to download because each additional piece of a web page
requires additional overhead for transmission over the network. Images should be
sliced only when necessary for interactivity.
Make sure that students understand that slices are not selections, shapes, or masks.
Discuss the differences between slices and these other items.

Creating slices based on layers
If the design of a web page is not final, layer-based slices may work best, because
they will automatically resize to match the layer on which they are based. If editing a
layer changes its size, you won’t have to re-do its slice to match.

Adobe Photoshop CS4 Classroom in a Book

35

Creating navigation buttons
This is a good place to have students check out the Slice Options dialog box. Have
them select another slice, and in the Slice Options dialog box, leave its Type as
Image. Point out the Name, URL, and Target options, and explain how filling in
these options here means that they don’t have to do it when coding the HTML,
especially if the graphics are edited and exported to HTML again.

Creating an animated GIF
From this procedure, students should understand how valuable it is to plan and execute a Photoshop design using layers if animation is an intended use for the graphic.
When a graphic represents the end of the animation, it’s much easier to start at the
end of the animation with the final graphic and work backwards to the beginning.

Tweening the position and opacity of layers
Tweening is another important animation strategy. Plan animations in terms of the
points at which major changes happen, animate to those points, and tween between
those points to fill in the rest. Tweening is much easier than trying to animate every
single frame by hand.

Exporting HTML and images
Some students may complain that they don’t see much difference between the versions of the thumbnail images they see in the Save For Web And Devices dialog box.
If so, treat that as a good thing. The key information—the file size, and therefore
the download time—is not apparent by looking at the images. For that, they have to
compare the metadata for each of the images.
Before completing work in the Save For Web And Devices dialog box, point out
the button in the top right of the preview area. Clicking this button reveals a panel
menu that changes the display of the selected preview area to simulate different
display conditions.
This menu is also available by right-clicking (Windows) or Control-clicking (Mac
OS) any of the preview panes. Also notice the Device Central button at the bottom right of the dialog box. This button allows emulating artwork (that doesn’t contain
slices) for display by various models of mobile devices, such as cell phones and PDAs.

Adding interactivity
Zoomify is useful for publishing high-resolution, large format images to the web.
For additional practice with this feature, you may want to suggest that students use
images from the Lesson13/Maps folder.
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Viewing the web gallery
Students may receive security warnings when they attempt to view the image gallery
on their web pages. In most browsers, you can bypass the security measure, especially since the student is viewing pages on a local system.
If the image gallery does not appear at all, have students verify the file name they
entered. The file name must match exactly for the browser to locate and play the
gallery file.

Questions
The following questions are not in the student’s Classroom in a Book.
1 How do you select a slice?
2 Describe five types of slices.
3 Why would you want to use a No Image slice?
4 What role do layers play in animating an image?
5 How do you control the delay between frames?
6 How can you make an animation appear smoother?
7 How do you decide whether to use GIF or JPEG format for a web graphic?

Answers
1 Use the Slice Select tool to select the slices. The Optimize Panel affects selected
slices only.
2 There are five types of slices:

• User slices are created manually with the Slice tool.
• Layer-based slices are created using the Layer > New Layer Based Slice
Command.

• Auto slices are automatically generated to fill in the gaps between the slices you
create.

• Subslices are a type of auto-slice generated when other slices overlap.
• No Image slices do not generate an image, but can contain a background color or
text.

3 A No Image slice is useful for an empty area of a web page. Because it doesn’t
generate an image, it can reduce a page’s download time.
4 Layers serve as reference points for frames and for important transitional events
in an animation, such as tweening.
5 In the Animation panel, click the Frame Delay menu under a frame.
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6 Use tweening to create additional frames.
7

Use GIF for flat-color graphics for images that only use a few colors, such as a
company logo. Use JPEG for continuous-tone images with subtle transitions or
many colors, such as full-color photographs.

Lesson 12: Working with 3D Images
It’s fun to work in three dimensions. Simply being able to rotate an object fully
can be very exciting. If your students have Photoshop CS4 Extended, this may be
their favorite lesson. However, the 3D features are available only in Photoshop CS4
Extended, so if you don’t have it, skip the lesson entirely.
For the best results, students should use computers with video drivers that support
OpenGL.

Goals for this lesson
Upon completing this lesson, students should understand how the three dimensions (width, height, and depth) work together in space, and how to manipulate
those dimensions using Photoshop’s 3D tools. They should also be familiar with the
3D panel, and should be able to work with the 3D (Scene) and 3D (Lights) panels
comfortably.

Mastering 3D concepts
Before you can use any of the 3D tools or features, you must be working with a 3D
layer. There are several ways to create a 3D layer. In this lesson, we cover how to
create a 3D shape from a layer, import a 3D file created in a 3D application, and
create a 3D postcard from a layer. Students may also choose 3D > New Mesh From
Grayscale > [any option] to experiment with that feature.
Point out how a 3D layer differs from a 2D layer in the Layers panel. Students may
not understand the differences between meshes, textures, and materials yet, but they
should recognize that there are many levels of complexity that can be modified to
accomplish different goals.

Creating a 3D shape from a layer
In the lesson, students create a hat shape using the image of a brick wall. Invite
students to try creating different shapes, including the donut, soda can, and cylinder
using the same image. They can also use their own images to create new 3D shapes.
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Manipulating 3D objects
Emphasize the difference between tools that move the 3D object and tools that
move the camera position. You may want to demonstrate this in the real world:
Invite a student to the front of the room, standing in front of a book, pen, or other
object. Then, move the object while the student (acting as the camera) remains still.
Replace the object, and instruct the student to move to a different position and
describe the new view. Note that the object itself hasn’t moved in relation to the
floor, desk, etc., but that the camera provides a different perspective.

Viewing 3D cross-sections
Cross-sections are intriguing. However, students can be disappointed when they try
to create cross-sections of 3D images that contain no interior details. Note that in
order to provide a useful cross-section, you must create a more detailed 3D image in
a 3D application. You can, of course, use cross-sections artistically without detailed
interiors.
Discuss with students why cross-sections might be useful to manufacturers, scientists, educators, engineers, and professionals in other fields.

Using the 3D Axis
On systems with OpenGL enabled, Photoshop displays the 3D Axis whenever a 3D
layer is active. The 3D Axis can give you greater control while you manipulate the
object on each axis. However, students may require a bit of practice to know which
axis is active and how the movement affects the object. Encourage them to play with
the 3D Axis until they feel comfortable with it.
You do not need to use the 3D Axis to accomplish any 3D task. It is a convenience,
not a requirement.

Questions
The following questions are not in the student’s Classroom in a Book.
1 How can you create a 3D layer from a 2D image?
2 How can you view a cross-section of a 3D image?
3 What does the 3D Axis represent? Which colors represent which axes?

Answers
1 Choose 3D > New 3D Postcard From Layer or 3D > New Shape From Layer
2 Select Cross-Section in the 3D panel.
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3 The 3D Axis represents the three axes you can manipulate in a 3D object. The
red arrow controls the x axis; the green arrow controls the y axis; and the blue
arrow controls the z axis. The box at the base of the 3D Axis scales the object.

Lesson 13: Working with Scientific Images
Though this lesson is designed to benefit professionals working with scientific or
technical images, it also includes some nice design techniques that can translate to
many applications—including highlighting an inset selection within an image and
creating dashed lines and custom borders.
Whether students have Photoshop CS4 Extended or not, it’s a good idea to briefly
introduce them to its capabilities—all the features in the standard edition of
Photoshop, plus functions for specialized markets, including technical image analysis, film and video work, and three-dimensional design. This lesson shows how to
use Photoshop Extended measurement and data analysis tools.
The students won’t change the appearance of the original sample files, other than to
label them. But they will rename them and add some metadata and keywords to the
remaining files.
Adobe Bridge is especially useful to students who work with digital cameras. Bridge
takes the sting out of sorting through large numbers of unnamed photographs that
do not have descriptive file.
Lesson 13 covers enhanced functions in Adobe Bridge as well as features of
Photoshop CS4 Extended. It’s possible that not all classrooms will have this version of Photoshop. However, students can partially complete the lesson, up to
“Measuring objects and data,” and then read through the rest.

Goals of this lesson
At the conclusion of this lesson, your students should know how to use Adobe
Bridge to find an image they want to open in Photoshop. They should also be familiar with the other Bridge functions: renaming files, ranking files, rotating images,
and previewing images and data associated with those files. They should understand how to use the Measurement feature in Photoshop CS4 Extended to measure
objects and record data, and to compare and analyze the information.

Viewing and editing files in Adobe Bridge
Make sure students understand that they do not have to use Bridge to open a file. If
they are not beginning computer users, they will already be familiar with the standard methods of selecting multiple items. If necessary, define the word contiguous.
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Creating a map border and work area
Point out to students that this technique for highlighting an inset (or an inverse
selection) is useful for other designs.

Making a custom border
Students can apply this technique of creating a dashed line—as well as creating a
custom border—to other design work.

Measuring objects and data
The Measurement feature lets you compute various measurements and record them
in the Measurement Log panel.
The Ruler tool in Photoshop calculates the distance between any two points in the
workspace. The Measurement feature in Photoshop Extended measures any area
defined with the Ruler tool or with a selection tool, including irregular areas selected
with the lasso, quick select, or magic wand tools.
The Measurement feature can also compute the height, width, area, and perimeter;
and it can track the measurements of one image or multiple images. Measurement
data is recorded in the Measurement Log panel, where it can be sorted or exported
to a spreadsheet file.
Emphasize to students the importance of beginning with a control measurement
against which they can verify the accuracy of other measurements.

Measuring irregular shapes
It may be useful to ask students how they would approach measuring areas and
objects of different shapes. Discuss strategies for measuring irregular shapes that
can’t be measured neatly between Point A and B.

Measuring in perspective with the Vanishing Point filter
For accurate measurement when using the Vanishing Point filter, students need to
position the pointer over the grid. A red border indicates a measurement was made
outside of the grid; results won’t be accurate.

Questions
The following questions are not in the student’s Classroom in a Book.
1 How can you rank images in Adobe Bridge?
2 How can you lighten a border area?
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Answers
1 Select an image or multiple images in Adobe Bridge, and then choose Label >
[star ranking] or a label ranking.
2 To lighten a border area, first select the interior, and then choose Select >
Inverse. Now the border is selected. Add a Hue/Saturation adjustment layer, and
increase the brightness.

Lesson 14: Producing and Printing
Consistent Color
Lesson 14 walks students through a basic color workflow, including printing a proof
and printing separations. Commercial printers have widely varying requirements for
color management. Students should understand the importance of discussing color
with the printer to understand how the appropriate settings to use for the job and
how to hand it off. It’s important that students understand the difference between
color correction and color management. Color correction fixes bad-looking color.
Color management can’t do that. The purpose of color management is to create an
accurate viewing environment so that you can anticipate the printed output.

Reproducing colors
Because the RGB gamut is much larger than the CMYK gamut, some people assume
that all CMYK colors fit within RGB. However, this is not true, because the gamuts
are different shapes that do not overlap perfectly. You may want to have students
examine the color gamut figure and point out the small areas of CMYK that are
outside the RGB gamut. Those CMYK colors cannot be reproduced on an RGB
monitor.

Specifying color management settings
The Color Settings dialog box can be intimidating, especially for beginners. You
might mention that the Color Settings dialog box is convenient because you set it
once and don’t worry about it again unless there is a major change in your workflow.

Proofing an image
The Missing Profile and Embedded Profile Mismatch dialog boxes can be very confusing. When you see one of these messages, yo can do one of two things:

• Leave the document as it is. This means choosing either to use the embedded

profile (if it exists) or leaving the document without a profile (if it doesn’t exist).
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• Adjust the document. If the document is missing a profile, you can choose to

assign one—either the current working space or a different profile. If you’re
opening a document with a mismatched profile, you can choose to discard the
profile, or convert the colors to the current working space.

When a profile mismatch occurs, you can also select Discard The Embedded Color
Profile (Don’t Color Manage). That means that Photoshop will neither change
the image’s color values nor will it embed a profile that records the current viewing environment. Therefore, the image may not look right on the screen even if its
colors are actually correct. This is valuable if a CMYK image is already tuned for
the press—any changes would mess it up. The two most likely rendering intents
to use for photographic images are Relative Colorimetric and Perceptual. The
more an image contains colors that are outside the destination gamut, the more
likely Perceptual might be a good idea. The Preview option in the Customize Proof
Condition dialog box is useful when deciding which one to use.
The appearance of an RGB image after converting to a CMYK gamut is often disappointing. Overall saturation is usually lower and some colors may shift. Reassure
students that Photoshop is simply being honest about which colors can actually be
achieved in the CMYK gamut at SWOP settings (assuming that all Color Settings
are set correctly).
It can be useful to do this exercise with two views open. You can have students
choose Window > Arrange > New Window for 16Start.tif to open a second window
for the image. Leave the first window as is, and use the second window for Proof
Setup. This way, a before/after comparison is possible.

Identifying out-of-gamut colors
It’s best to choose a color that is clearly out of gamut so that it can’t be confused
with any real colors in the image. A good way to do this is to specify a bright color at
maximum saturation.
You might mention exactly how Photoshop does the RGB-to-CMYK conversion. It
will start from the image’s RGB working space and convert to the current CMYK
working space. This means that the quality of the conversion depends on proper
settings and good profiles.

Questions
The following questions are not in the student’s Classroom in a Book.
1 What is a working space?
2 Which working spaces should you select in Color Settings?
3 How can you preview how an image will appear in final output?
4 How can you identify out-of-gamut colors?
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Answers
1 A working space is the color gamut within which Photoshop will adjust an
image’s colors.
2 The working spaces should be appropriate for the final output you are targeting.
3 Create a custom Proof Setup that uses a profile and settings that represent the
final output, then make sure View > Proof Colors is on and set to that setup.
4 Turn on View > Gamut Warning.
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